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Meet the Panel

Parker Anderson

EXPERT - PETE FOWLER CONSTRUCTION

Parker Anderson is an accomplished General Building Contractor with a Class B license serving as an

Expert with Pete Fowler Construction. Parker provides evaluation and testing on physical building

performance, examines enormous volumes of project documentation, and renders professional opinions

based on his findings that aid in moving projects to their conclusion. In this process, Mr. Anderson

frequently estimates project costs and tenders projects for bid. With extensive experience in residential

and commercial properties, Parker has worked closely with many large insurance companies and property

management accounts.

Parker has over 10 years of dedicated industry experience, and is constantly adding to his areas his

expertise through professional development and training. He has completed both the 10-hour OSHA

Construction Safety and Health certification as well as the OSHA 30 Hour Outreach Training for the

Construction Industry, and is also certified as a Water Damage Restoration Technician (IICRC).

Additionally, he has lent his knowledge to numerous projects and extensive reports, and he continually

finds thoughtful ways to increase productivity, support team members, and improve project efficiency.
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David Luxa

EXPERT - PETE FOWLER CONSTRUCTION

Dave Luxa is a construction professional with over 30 years of experience as a licensed general

contractor, supervisor, and manager. Throughout his career, he has been responsible for overseeing

construction and maintenance in a variety of settings with a strong emphasis on safety. Dave has an

extensive history as a contractor for commercial properties. He also holds licenses as a general contractor,

electrical contractor, and refrigeration contractor. Dave has studied green building and the LEED rating

system at UC Davis. He is a member of the National Fire Protection Association, and holds a certification

for HVACR. Dave’s unique, wide ranging experience has given him a strong understanding of projects

from all angles.

Mark Phillips

PARTNER - RESNICK & LOUIS, PC

Mark C. Phillips is a Partner in the Irvine office of Resnick & Louis, P.C. and has extensive experience in all

levels of analysis and litigation involving first- and third-party insurance coverage (including personal and

commercial lines), extra-contractual liability, SIU/EUOs, construction defect, catastrophic personal injury,

professional liability, premises liability, product liability, trucking, employment, and business litigation

matters, including trials, appeals, mediations, and arbitrations. Additionally, he has drafted a variety of

transactional documents and provided advice for corporate clients.

Presentation & Backup Materials

1. Lesson Plan with links to referenced Backup Materials

2. Power Point Slides
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INTRODUCTION 

"Building Claims" is a broad term that includes 
property, premises liability, general liability 
(GL), construction defect litigation, or 
construction contract claims. Lawyers call them 
"a case" when a lawsuit has been filed. Most 
claims get sorted out with little disagreement, 
where one party acknowledges having caused 
damage, everyone agrees to the value, and 
either they or their insurance company pay. On 
the other end are large, expensive, contentious 
claims that require a team of attorneys and 
experts to sort out. 

But there are claims in the middle where our 
clients need help. They might know their client 
caused damage, but think the costs are 
exaggerated. Or they might not be sure their 
client has liability. These require professional 
judgement by an experienced building expert 
who has knowledge of the law and insurance. 
This is where a "Desktop Review" is valuable. 
Desktop Review is sometimes called 
Preliminary Analysis, Level 1 Analysis, or Small 
Project Protocol They cost $1,500-10,000 and 
take a day to a week to complete. For claims 
professionals and defense lawyers our analysis 
is a "fight or pay" decision tool; it helps them 
decide "How much to pay vs. how much to 
fight." For plaintiffs or subrogation attorneys it 
is a "go/no-go" tool. 

 

 

 

PROGRAM OUTLINE 

1. Introduction 
2. Basic Analysis 
3. File Management 
4. Interviews & Testimony 
5. Estimating or Monetizing 
6. Presenting 
7. Conclusion 

BACKUP MATERIALS 

1. Property Damage Claim Analysis Basics by 
Pete Fowler  

2. Managing Expert Costs by Pete Fowler 
3. Understanding & Evaluating Construction 

Costs for Claims by Pete Fowler 
4. Level 5 Estimating 
5. Insurance Basics for Construction 

Professionals by Pete Fowler 
6. Civil Litigation Basics for Construction 

Professionals by Pete Fowler 
7. Allocation of Responsibility in Construction-

Defect Litigation by Pete Fowler 

 

 

 

 

 

 

http://www.petefowler.com/
https://intranet.petefowler.com/content/1156
https://static1.squarespace.com/static/5628ee3ee4b056cf2182763d/t/5c77032d652dead436e6c5d5/1551303472818/2A-Managing-Expert-Costs-09-03-11.pdf
https://www.petefowler.com/blog/2025/3/3/understanding-amp-evaluating-construction-costs-for-building-claims
https://www.petefowler.com/blog/2025/3/3/understanding-amp-evaluating-construction-costs-for-building-claims
https://files.petefowler.com/dc366514-0fc8-4574-9a1b-93869f0477fc/Graphic%20Level%205%20Estimating%202024-04-09%20A.jpg?v=1719766685
https://www.petefowler.com/blog/2021/8/9/insurance-basics-for-construction-professionals
https://www.petefowler.com/blog/2021/8/9/insurance-basics-for-construction-professionals
https://www.petefowler.com/blog/2023/11/6/civil-litigation-for-construction-professionals
https://www.petefowler.com/blog/2023/11/6/civil-litigation-for-construction-professionals
https://www.petefowler.com/blog/2022/allocation-of-responsibility-in-construction-defect-litigation
https://www.petefowler.com/blog/2022/allocation-of-responsibility-in-construction-defect-litigation
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 Desktop Review for Building Claims Webinar 
 Lesson Plan: December 2025 

 

PROGRAM CONTENTS 

1. Introduction - 5 Minutes 
A. Who We Are 
B. Presenter Information 
C. Program Introduction 
D. Learning Objectives  
E. Program Outline  

2. Basic Analysis - 10 Minutes 
A. Basic Analysis 
B. What we have, know, think, and 

recommend. 
C. Case Study: The Civil War in 100 

Words 
3. File Management - 10 Minutes 

A. DIKW: Data > Information > 
Knowledge > Wisdom. 

B. Pile ==> File ==>  
Knowledge ==> Solution 

C. Collect, Organize, Index, 
Summarize, understand (Analyze), 
Reference, Retrieve and Share 

D. Case Study: 20,000 Documents 
and Trial on Tuesday 

4. Interviews & Testimony - 10 Minutes 
A. Does this sound right? 
B. We Are Not Perry Mason 
C. Interviews, Testimony, 

Integrating, Referencing and 
Admissibility 

D. Case Study: It's Too Hard to Be 
Professional! 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

5. Estimating / Monetizing - 10 Minutes 
A. Level 5 Estimating 
B. Managing Expert Costs 
C. Costs Should Always Be an Issue 
D. Estimate Analysis & Comparison 
E. Case Study: Residing A Condo 

Development 
6. Presenting - 10 Minutes 

A. Explain it to Pete's Mom 
B. A diagram is worth 1,000 pictures 
C. Levels of Certainty, Presenting & 

Reporting 
D. Case Study: A Fall at the Mall  

7. Conclusion - 5 Minutes 
A. Continuing Education 
B. Backup Materials 
C. Feedback 

LEARNING OBJECTIVES 
• Explain what Desktop Review is and be 

familiar with common alternative names 
for this process.  

• Describe a Desktop Review’s purpose, and 
its value. 

• Discuss the activities involved in a Desktop 
Review. 

• Review case studies of Desktop Reviews.  
• Examine how estimating and monetizing 

these claims is performed. 
• Show what the final output of a Desktop 

Review looks like. 
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Desktop Reviews
for Building Claims

WEBINAR

With Parker Anderson, David Luxa, & Mark Phillips 

THURSDAY, DECEMBER 18TH, 2025 @ 10:00AM PT
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Building 
Experts.

ABOUT US

Helping Smart People
Make Smart Decisions

Construction Defects 

Property Claims

Personal Injury Claims

Contract Claims

Estimating, Quality & Construction  Management

Fire Claims
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ABOUT US

Project Map
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Mark PhillipsDavid LuxaParker Anderson

Meet our Presenters

4



9/25/2025

5

Program Outline
DESKTOP REVIEWS FOR BUILDING CLAIMS

Introduction

Basic Analysis

Interviews & Testimony

Presenting

Estimating or Monetizing

File Management

Conclusion
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Review case studies of 
Desktop Reviews.

Describe a Desktop 
Review’s purpose, and 
its value.

Examine how estimating and 
monetizing of these claims is 
performed.

Discuss the activities involved 
in a Desktop Review.

Explain what Desktop 
Review is and be 
familiar with common 
alternative names for 
this process.

Learning Objectives

Show what the final output of a 
Desktop Review looks like.
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Introduction
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Basic Analysis
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Basic Analysis

• Images, Maps, & Plans

• One Minute Summary

• Technical Summary

• Plan Summary

• Kanban & Actions

• Timeline

• Players

• Issues

• Key Files

• Inspection Summary
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What we have, 
know, think, 
and recommend.

10



9/25/2025

11

Case Study: 
The Civil War in 100 Words 

The American Civil War (1861-1865) was a conflict between the Union 

(the North) and the Confederacy (the South). The war's primary cause 

was a deep and fundamental disagreement over slavery, states' rights, 

and westward expansion. The election of Abraham Lincoln in 1860, 

who opposed slavery's expansion into new territories, was the catalyst 

for eleven Southern states seceding to form the Confederacy. The 

conflict began with the Confederate attack on Fort Sumter. Battles 

raged from Virginia to Mississippi, devastating communities. After four 

years of brutal warfare, the Union ultimately prevailed, preserving the 

nation and leading to slavery's complete and permanent abolition. 
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File Management
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DIKW: Data > Information > Knowledge > Wisdom

Wisdom

Knowledge

Information

Data
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Pile > File > Knowledge > Solution
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Collect, Organize, Index, Summarize, 
Understand (Analyze), Reference, 
Retrieve and Share
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Case Study: 
20,000 Documents
and Trial on Tuesday
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Interviews & Testimony
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“Does this sound right?”
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We Are Not
Perry Mason

Image: Perry Mason, CBS
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Interviews & Testimony: 
Integrating, Referencing & Admissibility
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Case Study: 
It’s Too Hard to Be Professional!
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Estimating / Monetizing
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Level 5 
Estimating
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Managing 
Expert Costs
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X`

Costs Should Always Be an Issue
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Estimate Analysis 
& Comparison
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Case Study: 
Residing a Condo Development
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Presenting
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Explain it to 
Pete’s Mom
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A Diagram is Worth  
1,000 Pictures
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Levels of Certainty

Levels of Presenting
Telephone
Web

In Person
Formal

Testimony

Levels of Reporting
Verbal / Informal

Meeting Agenda
Memo

Short Report
Long, Detailed Report
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Case Study: A Fall at the Mall
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Conclusion
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Review case studies of 
Desktop Reviews.

Examine how estimating and 
monetizing of these claims is 
performed.

Discuss the activities involved 
in a Desktop Review.

Explain what Desktop 
Review is and be 
familiar with common 
alternative names for 
this process.

Describe a Desktop 
Review’s purpose, and 
its value.

Learning Objectives

Show what the final output of a 
Desktop Review looks like.
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Continuing Education 
Credit will be reported
within 10 business 
days.
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We Want Your
Feedback
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